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YAZIM KURALLARI

Amisos Dergisi, yilda iki kez (Haziran-Aralik) yayimlanan ve tiim konferanslarda sunulan
tebliglerin metinlerini, bilimsel yenilik getiren, 6zgiin ve nitelikli makalelerini, kazi raporlari,
kitap tamitim1 ve elestiriler ile haberleri iceren simdilik Internet iizerinden yayimlanan
uluslararas1 hakemli bir dergidir.

Dergiye gonderilen makaleler 6n kontrol sonrasinda uygun bulundugu taktirde 2 hakeme
(kor hakemlik) gonderilir. ihtiyag olmasi halinde 3. hakeme de gonderilebilir. Gelen
makaleler alan yogunluguna gore makalenin ilk teslim tarihinden sonra ¢ikacak ilk sayida
yayimlanmasi beklenmemelidir.

Dergiye gonderilen yazilarin, daha 6nce yayinlanmamis veya bir baska dergiye yayin i¢in
teslim edilmemis olmalidir.

Dergiye gonderilecek olan yazilarin yazar tarafindan benzerlik raporu alinmali ve yazi ile
birlikte gonderilmelidir. Calismanin yayimlanmas: i¢in benzerlik oran1 %20'den fazla
olmamalidir.

Yayimlanmasi i¢in gdnderilen ¢alismalarin, akademik yazim kurallarina uyularak ve Tiirkge,
Almanca, Ingilizce veya Rusca dillerinden biri ile hazirlanmis olmasi gerekir.
Yayinlanan her tiirli ¢aligmanin yayin hakki dergiye aittir. Telif hakki formu doldurularak
yazi ile birlikte gonderilmelidir.

lgili editor gerekli gordiigii yazim diizeltmelerini kendisi yapabilir. Yabanci dildeki &zeti
yabanci dil editorii gerekli gormesi durumunda diizeltebilir.

Dergide yayinlanan yazilarda ileri siiriilen goriisler yazarlarini baglar. Yazilarin biitiin hukuki
sorumlulugu yazarlarma aittir. Yazarlar, yayin kurulu ve hakemlerin raporlarimi dikkate
almak zorundadirlar.

Yayimlanan yazilara telif iicreti 6denmez. Amisos, yazarlardan makale degerlendirme ve
yayin siireci i¢in herhangi bir ticret talep etmemektedir.

Dergiye gonderilecek bilimsel c¢alismalarda arastirma ve yayin etigine uyum konusunda
azami dikkat gosterilmelidir.

Yazi Teslim Kurallari

Amisos Dergisine gonderilen yazilar, Times New Roman, tek satir aralikli, 12 punto;
dipnotlar sayfa altinda ve 10 punto olarak verilmelidir. Ancak bazi alanlarin geregi olarak
yazim esnasinda 6zel font kullanilmis ise, bu fontlar makale ile birlikte gonderilmelidir.
Gonderilen yaz1 daha onceden yaymlanmamis ve yayimlanmak iizere herhangi bir dergiye
degerlendirilmek iizere sunulmamis olmalidir.

Etik Kurul Onay1

TUBITAK ULAKBIM TR DIZIN’in ilgili kurullarinca alman kararlara gére 2020 yil1 icin
TR DIZIN’de dizinlenen ve degerlendirme asamasinda olan tiim dergilerde yayinlanmak
lizere bagvurusu yapilacak derleme tiirii disindaki makalelerin yazarlarindan;
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Etik Kurul izni gerektiren arastirmalar

* Anket, miilakat, odak grup c¢alismasi, gozlem, deney, goriisme teknikleri kullanilarak
katilimcilardan veri toplanmasini gerektiren nitel ya da nicel yaklasimlarla ytiriitiilen her
tiirlii arastirmalar

+ Insan ve hayvanlarin (materyal/veriler dahil) deneysel ya da diger bilimsel amaglarla
kullanilmasi,

» Insanlar {izerinde yapilan klinik arastirmalar,
* Hayvanlar iizerinde yapilan aragtirmalar,

* Kigisel verilerin  korunmast  kanunu  geregince  retrospektif  caligmalar,
Ayrica;

* Olgu sunumlarinda “Aydinlatilmig onam formu”nun alindiginin belirtilmesi,

» Bagkalarina ait 6l¢ek, anket, fotograflarin kullanimi i¢in sahiplerinden izin alinmasi ve
belirtilmesi,

* Kullanilan fikir ve sanat eserleri i¢in telif haklar1 diizenlemelerine uyuldugunun belirtilmesi

Ayrintili Bilgi I¢in Linklere Tiklayimiz.

https://tubitak.gov.tr/sites/default/files/20689/ekbn_2020.pdf
https://tubitak.gov.tr/sites/default/files/20689/yasal_ozel_izin_belgesi_bilgi_notu.pdf

Sayfa Yapisi:

Metin boyutu: 12 punto
Dipnot boyutu 10 punto
Paragraf aralig:1 6 nk
Paragraf girinti: 1.25 cm
Ust kenar boslugu: 2,5 cm
Alt kenar boslugu: 2,5 cm
Sag kenar boslugu: 2,5 cm
Sol kenar boslugu: 2,5 cm
Satir araligi: Tek

Bashk:

Baslik, makaleyi betimleyici olmali, makalenin temel kavramlarini, tartismalarini ve temel
savin1 yansitmali ve miimkiinse 12 kelimeyi agmamalidir. Times New Roman yazi
karakteriyle 12 punto, biiyiik harflerle ve ortali olmali, yazilarin ve 6zetlerin iizerinde, sadece
yazinin basligr bulunmali, yazar adi yer almamalidir. Bir toplantida teblig edilmis ancak
yayimlanmamis olan bildirilerde toplantinin adi, tarithi ve yeri belirtilmelidir.
Yazarlar bilgilerini yazi metninde degil dergi sisteminde, isimlerini, tam ve agik kurum


https://tubitak.gov.tr/sites/default/files/20689/ekbn_2020.pdf
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adreslerini, telefon ve faks numaralarini, elektronik posta adreslerini ve ORCID ID'lerini
bildirmelidirler. Bu bilgiler, hakemlere gonderilmeyecektir.

Oz (Abstract):

Ozet metninin Times New Roman yaz1 karakteri ile 10 punto ile 150 kelimeden az, 250
kelimeden fazla olmayacak sekilde hazirlanmasi gerekmektedir.

Anahtar Kelimeler: Kelime 1, Kelime 2, Kelime 3, Kelime 4, Kelime 5 (En az 5 kavram
olmalidir.)

Abstract:

Dergimizde yayimlanacak her makalede bulunmasi zorunlu olan ingilizce zet (Abstract)
icin de yukarida verilen kurallarin uygulanmasi gerekmektedir.

Keywords: Word 1, Word 2, Word 3, Word 4, Word 5. (En az 5 kavram olmalidir.)

Ana metin

Times New Roman yazi karakteri ile 12 punto ile tek satir araliginda yazilip, paragraf
girintisi 1.25 cm ve once 0 nk sonra 6 nk paragraf bosluguna gore diizenlenmelidir. Metin
icinde vurgulanmasi gereken kisimlar egik harflerle (italik) yazilmalidir.

Alt Bashk

Makalede Times New Roman yazi fontu, 12 punto kullanilmalidir. Ancak bazi alanlarin
geregi olarak yazim esnasinda 6zel font kullanilmis ise bu fontlar makale ile birlikte sisteme
yiiklenmelidir.

Makalelerde kullanilacak kisaltmalarda TDK Yazim Kilavuzu esas alinmalidir.

Resimler, Cizimler, Grafikler:

Fotograflar, bilgisayar yazilimlarinda olusturulmus gorsellemeler, vb. resim olarak, ister elle
ister yazilimlarda ¢izilmis teknik resimler ¢izim olarak adlandirilmalidir. Bunlar haricindeki
diger gorseller de uygun bir adlandirma ile (6rnegin; harita, sekil, grafik)
degerlendirilmelidir. Resim, ¢izim, harita, sekil ve grafikler ardisik olarak
numaralandirilmalidir. Bunlara metin i¢inde (Res. 1), (Sek. 1), (Grafik 1) seklinde atifta
bulunulmalidir. Her bir gorsel i¢in uygun bir kisa tanim kullanilmali ve tanim gorselin altina
numarastyla birlikte yazilmalidir; ayrica gorsel bir baska kaynaktan alindiysa kaynak
bilgisine de yer verilmelidir. Gorsel malzemenin ¢oziiniirliigii en az 300 pixel/inch, uzun
kenar1 en az 15 cm, tam sayfa kullanilacak bir fotograf ya da ¢izim s6z konusu ise en az 22
cm olmalidir.

Tablolar:

Tablo bagliklari tablonun {istiinde-ortada, diger sekil, harita vb gorsellerin basliklar1 altinda-
ortada olmalidir.

Tablolar da ardisik olarak numaralandirilmalidir. Tablolara metin i¢inde numaralariyla (Tab.
1) seklinde atifta bulunulmalidir. Her bir tablo i¢in uygun bir baglik kullanilmali ve bu baslik
tablonun altina numarasiyla birlikte yazilmalidir. Ornek: Tablo 1: Canak ¢dmleklerin
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merkezlere gore dagilimi. Tablo baska bir kaynaktan alindiysa tablonun sol alt kdsesinde
belirtilmelidir. Ornek: Kaynak: 1983 tarihli ve 2863 say1li Kanun Hiikmii.

* Bu bicimsel ozelliklere gore diizenlenen makaleler sayfa simirlamasi olmamakla
beraber 30 sayfayr asmamasina 6zen gosterilmelidir.

DiPNOT VE KAYNAK GOSTERIMI

Dipnotta Sayfa Altinda Baska Eserlere Yapilan Atiflar (Times New Roman, 10 Punto)

* Yazar soyadi, yil ve sayfa kullanilarak “Yazar 1999, 113” seklinde yapilmalidir.

» iki yazarli eserlerde iki yazarin soyad1 “Yazar-Yazar 2000, 120" seklinde kullanilmalidir.

» Daha c¢ok yazarli eserler, yalnizca ilk yazarin soyadi verilerek “Yazar vd.” seklinde ve yine
benzer bigimde yi1l ve sayfa numarasi yazilarak kullanilmalidir.

» Atifta bulunulan eserler Kaynak¢a boliimiinde ilk yazarin soyadina gore alfabetik liste
olarak siralanmalidir.

» [k yazar1 ayn1 olan eserlerde siralamay1 belirlemek icin sirastyla ikinci ve daha sonra gelen
yazarlarin soyadlar1 kullanilmalidur.

* Tlim yazarlar1 ayni olan eserler yilina gore eskiden yeniye dogru siralanmalidir.

* Tim yazarlar1 ve yillar1 ayni1 olan eserler ise yilin sonuna eklenen kiiciik harfler
kullanilarak “1999a” ve “1999b” seklinde birbirlerinden ayrilmalidir.

» {lk yazar1 ve y1l1 ayni1 olan ii¢ ve daha fazla yazarli eserler de ayn1 sekilde ayrilmalidur.
* Metnin tiimii, ara basliklar dahil, son notlar (endnote) harig, araliksiz olarak yazilir.

* Metinde dipnotlar, ilgili oldugu sayfada numaralandirilarak verilir; metin sonuna konulmaz.

Kaynakca (Times New Roman, 12 punto):

» Kaynakgada tiim yazarlarin soyadlar1 ve diger adlarmin ilk harfleri yer almalidir. Kaynaklar
asagidaki orneklere uygun olarak yazilmalidir.

» Kaynak¢ada ayn1 yazarin ¢ok sayida kaynagi varsa, kaynaklar eskiden yeni tarihe dogru
siralanarak yazilir. Aym tarihli kaynaklarda harf ile siralama yapilir. Ornegin: 2000a,
2000b.

Dingol, A.—Dingol B. 1992, “Die Urartaeische Inschrift aus Hanak (Kars)”, H. Otten — E.
Akurgal-H. Ertem-A. Siiel (eds.), Hittite and other Anatolian and Near Eastern
Studies in Honour of Sedat Alp, Ankara, 109-117.

Karaosmanoglu, M. 2010, “Yeni Bulgular Isiginda Altintepe Urartu Tapinag1”, XV. Tiirk
Tarih Kongresi, I, Ankara, 209-220.

Oniz, H. 2008, Arkeolojik Sualti Arastrmaciligina Giris Igin Egitim Metodolojisi, Selguk
Universitesi, Sosyal Bilimler Enstitiisii, Arkeoloji Anabilim Dali, (Yaymlanmamis
Yiiksek Lisans Tezi), Konya.

Yakar, J. 2003, “Identifying Migrations in the Archaeological Records of Anatolia”, B.
Fischer—-H. Genz-E. Jean-K. Koéroglu (eds.), Identifying Changes: The Transition
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from Bronze to Iron Ages in Anatolia and its Neighbouring Regions, Procceding of
the International Workshop Istanbul, Nowember 8-9, 2002, istanbul, 11-19.

Yigitpasa, D. 2016, Dogu Anadolu Ge¢ Demir Cagi Kiiltiirii, Ankara.

Internet Kaynaklar1 asagidaki gibi verilmelidir:
URL 1 http://imgkid.com/tibial-fibular-notch.shtml

MAKALELERIN GONDERILMESI

Yukaridaki ilkelere uygun olarak hazirlanmis makaleler, MAKALE GONDER SISTEMI
tizerinden gonderilmelidir. E-mail yoluyla gonderilen makaleler dikkate alinmamaktadir.
"MAKALE GONDER SISTEMIi"nden makale géndermek igin:

* ULAKBIM/DergiPark’a iiye olduktan sonra, kullanici adi (sisteme kaydedilen e-mail
adresi) ve sifre ile sayfaya girilmelidir.

* Acilan sayfada "makale gonder" boliimii agilarak ilgili bosluklar doldurulmalidir.

* Makale word dosyasi halinde, yazar bilgileri olmadan sisteme yiliklenmelidir. Kér hakemlik
stirecinin daha saglikli yiiriitiilebilmesi i¢in yazarlarimizin bilgilerini paylagsmamalarina
dikkat etmeleri gerekmektedir. Ayr1 bir word dosyasinda yazar bilgileri eklenebilir.

Yazar bagimsiz hakem degerlendirmesinin saglanmasi

Bagvurularin yazar bagimsiz degerlendirilmesi, yazar ve hakem kimliklerinin birbirlerine
bildirilmemesi i¢in gayret gosterilmektedir. Bu amagla sisteme dosya gonderen yazar, editor,
hakem gibi kisilerin metin ve dosyalar ile ilgili asagidaki noktalara dikkat etmeleri gerekir.

Yazarlar metinde adlar1 ve kurumlar1 gegen yerleri silmelidirler. Sayfa alt1 notlar1 vb yan
metinler dahil olmak iizere Mikrosoft belgeleri saklanir iken dosya bilgileri icine kisisel
bilgiler de yazilir. Bu nedenle ya bu kisisel bilgiler belge 6zelliklerinden bulunup silinmeli,
ya da asagidaki sira ile belge kisisel bilgi igermeyecek bigimde yeniden kaydedilmelidir.
(File > Save As > Tools (or Options with a Mac) > Security > Remove personal information
from file properties on save > Save) (Dosya > Farkli Kaydet > Araglar > Giivenlik > Kisisel
bilgileri silerek kaydet > Kaydet)

PDF dosyalarda da Adoba Acrobat ana meniisiinden belge ozellikleri segilerek, yazar adi
silinmelidir.
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PUBLICATION INSTRUCTIONS

Amisos Journal is an international peer-reviewed journal that is published twice a year (June-
December) and includes the texts of the papers presented at all conferences, scientific
innovations, original and qualified articles, excavation reports, book introduction and
criticism and news.

Articles sent to the journal are sent to 2 referees (blind refereeing), if deemed appropriate,
after pre-control. If necessary, it can be sent to the 3rd referee. Incoming articles should not
be expected to be published in the first issue after the first submission date of the article,
depending on the field density.

Manuscripts submitted to the journal must not have been published before or submitted to
another journal for publication.

The similarity report of the articles to be sent to the journal should be obtained by the author
and sent with the article. The similarity rate for the publication of the study should not be
more than 20%.

Manuscripts submitted for publication must be prepared in accordance with the academic
writing rules and in one of Turkish, German, English or Russian languages.

The copyright of any published work belongs to the journal. The copyright form should be
filled in and sent with the article.

The relevant editor can make the spelling corrections he deems necessary. The summary in a
foreign language can be corrected if deemed necessary by the foreign language editor.

The opinions expressed in the articles published in the journal bind its authors. All legal
responsibility of the articles belongs to their authors. Authors must consider the reports of the
editorial board and referees.

No royalty fee is paid for published articles. Amisos does not charge any fee from the authors
for the article evaluation and publication process.

In scientific studies to be sent to the journal, maximum attention should be paid to
compliance with research and publication ethics.

Article Submission Rules

Articles sent to Amisos Magazine, Times New Roman, single line spacing, 12 pt; footnotes
should be given at the bottom of the page in 10 font size However, as a requirement of some
fields, if a special font is used during writing, these fonts should be sent with the article. The
submitted article should not have been published before and should not be submitted to any
journal for evaluation.

Ethics Committee Approval

According to the decisions taken by the relevant boards of TUBITAK ULAKBIM TR
DIZIN, among the authors of the articles that are indexed in TR DIiZIN for 2020 and to be
submitted for publication in all journals that are in the evaluation phase;
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Research requiring the permission of the Ethics Committee

* All kinds of research conducted with qualitative or quantitative approaches that require data
collection from participants using questionnaires, interviews, focus group work, observation,
experimentation, interview techniques.

* Use of humans and animals (including material / data) for experimental or other scientific
purposes,

¢ Clinical trials on humans,

» Research on animals,

Retrospective studies in accordance with the law on protection of personal data,
Also;

» Stating that "informed consent form" was obtained in case presentations,

» Obtaining and indicating permission from the owners for the use of scales, surveys and
photographs belonging to others,

« Stating that copyright regulations are complied with for the intellectual and artistic works
used.

Click on the links for detailed information.
https://tubitak.gov.tr/sites/default/files/20689/ekbn 2020.pdf
https://tubitak.gov.tr/sites/default/files/20689/yasal ozel izin belgesi bilgi notu.pdf

Page structure:

Text size: 12 points
Footnote size 10 points
Paragraph spacing: 6 pt
Paragraph indent: 1.25 cm
Top margin: 2.5 cm
Bottom margin: 2.5 cm
Right margin: 2.5 cm

Left margin: 2.5 cm

Line spacing: Single

Title:

The title should describe the article, reflect the basic concepts, discussions, and main
argument of the article and, if possible, should not exceed 12 words. It should be in Times
New Roman font with 12 pt, capital letters and centered, on the manuscripts and abstracts,
there should only be the title of the article and not the name of the author. In papers that were
delivered but not published at a meeting, the name, date and place of the meeting should be
specified.


https://tubitak.gov.tr/sites/default/files/20689/ekbn_2020.pdf
https://tubitak.gov.tr/sites/default/files/20689/yasal_ozel_izin_belgesi_bilgi_notu.pdf
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Authors should provide their information not in the manuscript but in the journal system,
their names, full and open institution addresses, telephone and fax numbers, e-mail addresses
and ORCID IDs. This information will not be sent to the referees.

Abstract:

The abstract should be prepared in Times New Roman font with 10 font size, not less than
150 words and not more than 250 words.

Keywords: Word 1, Word 2, Word 3, Word 4, Word 5 (There should be at least 5 concepts.)

Abstract:

The rules given above must also be followed for the English abstract, which is mandatory for
every article to be published in our journal.

Keywords: Word 1, Word 2, Word 3, Word 4, Word 5. (There must be at least 5 concepts.)

Main text

It should be written in Times New Roman font with 12 pt and single line spacing, and the
paragraph indent should be 1.25 cm and first 0 pt, then 6 nk paragraph spacing. The parts that
need to be emphasized in the text should be written in italics.

Subtitle

The article should use Times New Roman font and 12 pt. However, as a requirement of some
fields, if a special font is used at the time of writing, these fonts should be uploaded to the
system with the article.

The abbreviations to be used in the articles should be based on the TDK Spelling Guide.

Pictures, Drawings, Graphics:

Photographs, computer software visualizations, etc. As drawing, technical drawings drawn
either by hand or in software should be named as drawing. Other visuals should be evaluated
with an appropriate naming (eg map, figure, graphic). Pictures, drawings, maps, figures and
graphics should be numbered consecutively. These should be referred to in the text as (Fig.
1), (Fig. 1), (Graph 1). An appropriate short description should be used for each visual and
the description should be written under the image with its number; In addition, if the visual is
taken from another source, the source information should also be included. The resolution of
the visual material should be at least 300 pixels / inch, the long edge should be at least 15
cm, and in the case of a full-page photo or drawing, it should be at least 22 cm.

Tables:

Table titles should be above-in the middle of the table, under the headings of other figures,
maps, etc. in the middle.

Tables should also be numbered consecutively. Tables should be referred to in the text as
numbers (Tab. 1). An appropriate title should be used for each table and this title should be
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written under the table with its number. Example: Table 1: Distribution of pottery by center.
If the table is taken from another source, it should be specified in the lower left corner of the
table. Example: Source: Act No 2863 of 1983.

* Articles arranged according to these formal features do not have a page limitation, but
should not exceed 30 pages.

FOOTNOTE AND REFERENCES
Citations to Other Works Below the Page in Footnote (Times New Roman, 10 font size)

* It should be made in the form of "Author 1999, 113" using the surname of the author, year
and page.

» For works with two authors, the surnames of the two authors should be used as "Author-
Author 2000, 120".

* Works with more authors should be named "Author et al." By giving only the first author's
surname. and again similarly by writing the year and page number.

* The cited works should be listed alphabetically in the Bibliography section, according to
the surname of the first author.

» For works whose first author is the same, the surnames of the second and subsequent
authors should be used respectively to determine the order.

* Articles with the same authors should be listed according to their year from old to new.

* The works with the same authors and years should be distinguished from each other as
"1999a" and "1999b" using the lower case letters added to the end of the year.

» Works with three or more authors with the same first author and year should be separated in
the same way.

* The entire text, including subheadings, excluding the endnote, is written continuously.

* Footnotes in the text are given by numbering on the relevant page; it is not put at the end of
the text.

Bibliography (Times New Roman, 12 pt.):

* The bibliography should include the surnames of all authors and the first letters of their
other names. References should be written according to the examples below.

* If there are many references of the same author in the bibliography, the references are
written in order from the old to the new date. The sources with the same date are listed by
letter. For example: 2000a, 2000b.

Dingol, A. — Dingol, B. 1992, “Die Urartaeische Inschrift aus Hanak (Kars)”, H. Otten — E.
Akurgal-H. Ertem—A. Siiel (eds.), Hittite and other Anatolian and Near Eastern
Studies in Honour of Sedat Alp, Ankara, 109-117.

Eker, F. 2019, “Antik¢agin Siisii: Kahramanmaras Miizesi’ndeki Kaburgali ve Burma Cam
Bilezikler”, TUBA-AR, 25, 163-171.

Karaosmanoglu, M. 2010, “Yeni Bulgular Isiginda Altintepe Urartu Tapmagi”, XV. Tiirk
Tarih Kongresi, I, Ankara, 209-220.
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Oniz, H. 2008, Arkeolojik Sualti Arastrmaciligina Giris I¢in Egitim Metodolojisi, Selguk
Universitesi, Sosyal Bilimler Enstitiisii, Arkeoloji Anabilim Dali, (Yayinlanmamis
Yiiksek Lisans Tezi), Konya.

Yakar, J. 2003, “Identifying Migrations in the Archaeological Records of Anatolia”, B.
Fischer-H. Genz-E. Jean-K. Koroglu (eds.), Identifying Changes: The Transition
from Bronze to Iron Ages in Anatolia and its Neighbouring Regions, Procceding of
the International Workshop Istanbul, Nowember 8-9, 2002, istanbul, 11-19.

Yigitpasa, D. 2016, Dogu Anadolu Ge¢ Demir Cagi Kiiltiirii, Ankara.

Internet Kaynaklar1 asagidaki gibi verilmelidir:
URL 1 http://imgkid.com/tibial-fibular-notch.shtml

SUBMITTED ARTICLES

Articles prepared in accordance with the above principles should be sent via the
SUBMISSION SENDING SYSTEM. Articles submitted via e-mail are not considered. To
submit an article from the " SUBMISSION SENDING SYSTEM":

* After subscribing to ULAKBIM/DergiPark, you should enter the page with
username (e-mail address saved in system) and password.

* In the opening page, the "send article™ section should be opened and the related
spaces should be filled in.

* The article should be loaded into the system as a word file. In order for the blind
arbitration process to be carried out better, the authors should be careful not to share their
knowledge. Author information can be added in a separate word file.

Author independent peer review

Independent evaluation of the applications of the author, authors and referees are not being
reported to each other. For this purpose, people who send files to the system, such as authors,
editors, referees should pay attention to the following points about text and files.

Authors should delete names and institutions in the text. The page information is also written
into personal information while the page is stored in the Microsoft documents including sub-
texts etc. Side texts. Therefore, either these personal information must be found and deleted
from the document properties, or the document in the following order should be re-recorded
so that it does not contain any personal information. (File> Save As> Tools> Security>
Delete Personal Information> Save)

In PDF files, the author name should be deleted by selecting document properties from the
Acrobat main menu.


http://imgkid.com/tibial-fibular-notch.shtml

